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Getting Started in InDesign

Before opening InDesign, make sure you have installed the Twixl Publisher plug-in
according to these instructions .

When you have started InDesign, select the Window menu, then navigate to  Extensions
-> Twixl Publisher to open the palette. You will notice a number of options are available in
the palette.

If no object is selected in InDesign, the publication management options will be available.

If a certain object (like a movie or image) is selected, depending on the type of object,
the relevant options for different interactive elements will be displayed.

When creating InDesign content with Twixl Publisher, there are two different
approaches to creating your content:

1. Article-based
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https://twixlmedia.zendesk.com/hc/en-us/articles/115000739545-installation

Create individual articles that can be uploaded to a collection on the Twixl platform -
this works best when multiple designers are working on content for the same app, or
when you have an app with frequently updated content.

2. Publication-based

Create a complete publication, using an InDesign book to manage the different
articles - this works best if only one designer is working on the publication. When
importing a Twixl publication to an app on the platform, it will automatically be split
into a collection with individual articles for each of the InDesign articles.

You can decide to create and export individual articles separately. When you export an
article, the exported file will have the extension .article .

Just zip that .article file, and it can be uploaded to the platform.

For more details about adding content to your app, please check Working with Content
ltems .

Twixl Publisher supports 5 different sizes , each of them in landscape and portrait:

¥ iPad (1024x768 and 768x1024 pixels)

¥ Android 10 inch (1280x752 and 752x1280 pixels)

¥ Android 7 inch - Kindle Fire (1024x552 and 552x1024 pixels)
¥ Phones (568x320 and 320x568 pixels)

¥ Phones XL (852x393 and 393x852 pixels)

New articles or publications created by the Twixl Publisher plug-in will use a specific
naming convention for the alternate layouts:

¥ iPad: "iPad H" for landscape and "iPad V" for portrait

¥ Android 10 inch: "Android 10" H" for landscape and "Android 10" V" for portrait

¥ Android 7 inch: "Kindle Fire/Nook H" for landscape and "Kindle Fire/Nook V" for portrait
¥ Phones: "Phone H" for landscape and "Phone V" for portrait

¥ Phones XL: "Phone XL H" for landscape and "Phone XL V" for portrait

IMPORTANT NOTE:

If you create documents manually, i.e. by selecting New Document from the File
menu instead of using the plug-in's ‘New article’ menu option), make sure your
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alternate layouts use the naming convention above, and that your documents
have the page size Twixl Publisher expects . If you have layouts with a different

name, you'll receive an error message during preflight.

Select "New Publication”. Once you select a publication name and optional issue number,
the plug-in will create a "book" in InDesign.

An InDesign book file is a collection of documents that can share styles, swatches,
master pages, and other items.

There are two options for displaying your Table of Contents (TOC)

¥ Title Bar Button (default)
¥ If you do not want to display a TOC viewer at all, select the option " None "

If you choose " Title bar button E" a TOC icon will appear in the right corner of the title bar,
that will become visible when tapping anywhere on a page of your publication. If you
also defined a hamburger menu __in your app, it will appear to the left of that menu.
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Initial article

You can create the first article of your publication, as well as select its title and optional
tagline (these will be displayed in the TOC Viewer).

You can also select your starting template. The template you select for your first article
will become the default template for that publication.
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Creating articles

Every article in your publication will be a single InDesign document. You can create
documents consisting of one or more pages, or alternatively you can create long
pages of any length.

¥ Any article can consist of one or more "pages", and you'll be able to navigate from one
to the other on the iPad via vertical swiping.

¥ Horizontal swiping from within any page of an article will always navigate to the first
page of the next article.

¥ If you check the publication option 'Horizontal swiping only', then all pages from the
different documents can only be navigated horizontally, independent of how you
organized them in InDesign.
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You can also opt to have a page with the correct width, but with a length of your
choosing, similar to a web page. That way, instead of navigating vertically from page to
page, a user can continuously scroll through a longer document.

IMPORTANT NOTE

If you work with ‘long pages', you are limited to one page per article.

Select "New article" from the  Twixl Publisher palette (if you are using a publication-based
workflow, a new InDesign document will be added to the book file).

IMPORTANT NOTE:
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While it is always recommended to use the Twixl Publisher plug-in panel to
create new articles, sometimes you may have legacy content that you want to
re-use. In that case, make sure to check out the article " Page sizes ".

Select one of the included templates to start your design.

¥ The "File name" will be used to name your InDesign document.

¥ The "Title" is an optional title that will be displayed in the thumbnail viewer or in the
Table of Contents overview.

¥ The "Tag Line" is an optional extra line of information that will be displayed in the Table
of Contents overview below the Title.

¥ The "Author" is exactly that.

¥ Article Options: "Show article in TOC": allows you to select whether the thumbnail for
this article will be visible in the Table of Contents overview.

¥ If you are using a book, articles can be reordered to change the order in which they
will appear on the tablet. If you want to change the properties for your article
afterwards, select "Article Properties” from the Twixl Publisher palette.
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"TemplatesE": You can create templates for your designs. Twixl Publisher templates
should be saved as InDesign template files (.indt) and should be stored at one of the
following locations:

~/Library/Application Support/Twixl Publisher Plugin/Templates/ (user level)
(navigate to this folder using the "Templates” button in the "New Article" window)
/Library/Application Support/Twixl Publisher Plugin/Templates/ (root level)

A number of alternate layout templates will automatically be installed. The alternate
layouts used in the templates use a specific naming convention. Check the " Working with
alternate layouts " section for more details.

There is nothing to configure in order to support standard resolution iPads as well as
retina iPads. The plug-in automatically and transparently generates the artwork for the
retina iPad in addition to the artwork for the standard resolution iPads. You just create
your design at 768x1024 (portrait) and 1024 x 768 pixels (landscape), but the only
requirement is that in order to obtain the optimal resolution for retina iPads as well, your
images should have an effective ppi of 144 (you can check this in the link info panel).
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If you are creating content for phones , note that you should have an effective ppi of 280
in order to obtain the optimal output quality. The Twixl Publisher preflight process will
generate a warning if your images have a lower resolution.
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Working with alternate layouts

With Twixl Publisher and InDesign, you can take advantage of the liquid layout/
alternate layout options. When using alternate layouts, we recommend starting your
design based on a single layout format, e.g. iPad Landscape. You can then define the
liquid layout options for each of your pages.

PREREQUISITES:

Using the Twixl Publisher Alternate Layout functionality requires that you know the
concepts of  Liquid layouts and Alternate Layouts in InDesign :

1. Start by creating a new publication.

2. Once your design is more or less complete for the form factor you started with, and if
you have set liquid layout rules for your objects, then the "Alternate LayoutsE" option in
the main view of the plug-in allows you to generate different versions for all your
articles automatically.
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E.qg. if your first layout was iPad landscape, you will now be able to create the different
alternate layouts automatically, in a single click, for all articles in your publication.

The plug-in will detect which articles already have alternate layouts defined, and will only
offer to add them to those documents where they are not yet available.
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New articles or publications created by the Twixl Publisher plug-in will use a specific
naming convention for the alternate layouts:

¥ iPad: iPadH forlandscape and IPad VV  for portrait

¥ Android 10 inch:  Android 10 inch H for landscape and Android 10 inch V for
portrait

¥ Android 7 inch:  Android 7 inch H for landscape and Android 7 inch V for
portrait

¥ Phones: Phone (XL) H  for landscape and Phone (XL) V  for portrait

IMPORTANT NOTE:

If you create documents manually (and not from the plug-in's ‘New article’ menu
option), make sure your alternate layouts use the naming convention above. If
you have layouts with a different name, the preflight will generate an error. See
also the article " Page sizes "

TIP:

If you want to create two Android layouts for both 10" and 7" versions, the best
approach is to first create the Android 10" alternate layout based on the iPad
layout, then make adjustments for the different aspect ratio, and once you're
happy with the Android 10" layout, you can generate the 7" version that will be
based on that.

Creating Alternate Layouts is a cumbersome process. It requires both time and
manpower. A lot of publishers decide to support only one Orientation (either Portrait or
Landscape) and that's perfectly understandable. If you do that, we advise you to follow
these guidelines:

¥ Think before you choose which Orientation you'll support: Landscape Only designs
are better suited if you have a lot of full screen Web Overlay Buttons or photos. Portrait
Only layouts are more popular on smartphones.

¥ Go for dummy-content: It's always a good idea to provide your reader with extra
instructions, telling them to rotate their device so they can see the content!
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ABOUT ANDROID TABLETS:

If an Android device has a screen ratio of 4:3 |, the iPad version will be shown (if
provided). If the device has different aspect ratio, the Android version will be
used.
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Page Sizes

When you create articles in Twixl Publisher, the alternate layouts are expected to be

of a specific size. Here's an overview:

Alternate Layout
iPad
Android 10"
Android 7"
Phone

Phone XL

Landscape
1024 x 768 px

1280 x 752 px
1024 x 552 px
568 x 320 px

852 x 393 px

Portrait

768 x 1024 px
800 x 1232 px
600 x 976 px
320 x 568 px

393 x 852 px

If you create new articles directly from the Twix| Publisher panel, these sizes will be used
automatically. If you want to create long pages, then you can always adjust the height,
but the width needs to be as specified in the diagram above.

TIP:

The maximum height for along page is 14400 px for tablets and phones (the
Twixl Publisher Preflight will warn you if the Maximum Page Size exceeds the limit).

Don't exaggerate with long pages, because you don't want your reader to "get
lost" while reading!

If you want to adapt existing content of a different size for use with Twixl Publisher, you will
need to:
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¥ Set up the alternate layout name correctly (i.e. "iPad V", "iPad H", "Android 10 inch V",
"Android 10 inch H", "Android 7 inch V", "Android 7 inch H", "Phone V", "Phone H", "Phone XL
V", "Phone XL H")

¥ Use the pages panelto  change the page size
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Creating content for phones

In Twixl Publisher, you can create an alternate layout for phones. As of Twixl Publisher 22.2,
there are two different sizes for phones, ' Phone ' (for somewhat older phones with a 16 by
9 aspect ratio, and ' Phone XL ' (for most recent phones, with an aspect ratio of 19.5 by 9).

To do this for an existing document, open your publication, then click the 'Alternate
layouts" option in the plug-in and you'll have an extra option to create a '‘Phone’' and a
'Phone XL' version of your content. If you only want to create a phone layout in a new
article, select the 'Phone (XL) Portrait' or 'Phone (XL) Landscape' template.

IMPORTANT NOTE:

Do not use Adobe's built-in alternate layout "iPhone" from the Pages panel. Use
the Twixl Publisher plug-in panel to create the phone versions instead.
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The "Phone 16:9 V" alternate layout is 320 pixels wide and 568 pixels long. The "Phone 16:9
H" is 568 pixels wide and 320 long.

The "Phone 19.5:9 V" alternate layout is 393 pixels wide and 852 pixels long. The "Phone
19.5:9 H" is 852 pixels wide and 393 long.

When both 'Phone’ and 'Phone XL' layouts are available, the image dimension closest to
the screen resolution will be used, otherwise the images will be scaled.

If you are creating content for phones, note that you should have an effective ppi of 280
in order to obtain optimal output quality on recent phones.

Twixl publications uploaded to the Twixl Distribution Platform will be split automatically
into separate versions for the different platforms (iPad, iPad retina, Android 10" & Android
7", and phones).

You can check if you uploaded a publication that supports all the platforms by checking
the file sizes of the publication.

The advantage is that a reader will only need to download the contents relevant for his
device.

When exporting a 'Phone' layout from InDesign, Twixl Publisher will automatically
generate different phone resolutions. For Android phones, Twixl Publisher will
automatically select the version that is the closest to one of the formats.

On the Twixl platform, the  Build for option in the build settings for your app offers three
choices:

¥ Tablets (only)
¥ Phones (only)
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¥ Tablets & Phones (universal)

This let you decide which type of app you want to create.

IMPORTANT NOTE:

Building for phones requires that your InDesign export contains a Phone alternate

layout. Also, if you submit a universal iPhone/iPad app to Apple, it is not possible
to later update thistoa  Tablet only or Phone only version.
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Online/offline content in InDesign web
viewers or web overlays

In a web viewer or web overlay, you can refer to a remote url or to a local
WebResource, depending on whether a user is online or not.

With a remote url, the user needs to be online in order to see the contents. With a local
WebResource, the contents is embedded in the InDesign article, so you donOt have to be
online in order to see the contents. Imagine you want to mix both options. As you never
know upfront if the userOs device is going to be online or not, you would like to have a
check that displays a remote URL if the device is online. And if the device is offline, it
would be nice if we could show a local WebResource instead. You will need to use some
JavaScript to accomplish this though.

The sample file contains a publication with 3 different articles:

¥ The first article shows a web viewer containing a link to a remote website.

¥ The second article shows a local WebResource which is embedded in the publication

¥ The third article is a smart article. It will check if the device is online, and if it is, it will
show a link to a remote web site. If the device is offline, it will show a local
WebResource which is embedded in the publication.

The way weOve implemented it in the third article is by adding an extra file called
check.html in the WebResources folder for the publication. In that file, weOve pasted the
following HTML code:

<html>

<head>
<title>Check If The Device is Online or Not</title>
</head>

<body>

<script type="text/javascript">
if (navigator.onLine) {
window.location.href = "http://blog.twixImedia.com/assets/are-we-online/online.
html";
}else {
window.location.href = "offline.html";

}

</script>

</body>
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</html>

ILJ Click to copy
Whenever the page gets loaded, it will execute the script. With the call to
navigator.onLine (case-sensitive), it will ask the web browser if there is an internet
connection. If there is an internet connection, it will redirect to the HTTP url, if not, it will
show the local WebResource. If you preview the sample publication on your device, load
it first with a network connection. On the third article, it will tell you that an online page
was loaded. If you then e.g. turn on Airplane mode in the system settings and open the
publication again, the third article will automatically load the offline file. This technique is
very handy if you have certain content that is only available online. Using this check, you
can show a proper message to the user indicating that he/she needs to be online to view
that content.

Download the sample files
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InDesign interactivity
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Buttons

Add actions to objects

Action buttons can be created via the Window -> Interactive -> Buttons and Forms.

When you convert an object to a button, an action can be attached to it. The event type
should be On Release or Tap .

The actions that can be attached to a button are shown in the screenshot below:

IMPORTANT NOTE:

Only a specific number of options in the Action menu are supported by Twixl
Publisher, i.e.:

¥ Go To First Page
¥ Go To Last Page
¥ Go To Next Page
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Go To Previous Page

Go To URL

Play a Sound

Play a Video

Go To Page

Go To State (of a multi-state object - slide show)
Go To Next State

Go To Previous State

K K K K K K K K

Buttons appearances are supported in Twix| Publisher if you use the Obutton
appearancesO in the Obuttons and formsO panel.

The Twixl Publisher plug-in will look at the Normal and Click states. If you have defined
these two button states, you will see that in the Twixl reader software, they work as a
OtoggleO button. Everytime you tap the button, it toggles from the "Normal" to the "Click"
state and back.

TIP:
It is recommended to always add a Click State , even if they have the same look.
Buttons without a  Click State defined, can result in problems with unresponsive
Actions.

We allow you to create a special type of button, called " Web Overlay Button ", that will

trigger a modal web viewer to be displayed on top of your page.
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Hyperlinks

Add links to text or objects.

Hyperlinks can be defined in InDesign via the Window -> Interactive ->
Hyperlinks palette.

Three types of hyperlinks are supported:

¥ Page link
¥ URL link
¥ Email link

Select the object or highlight the text you want to define as a link, then choose "New
HyperlinkE" from the palette.

Note that page hyperlinks from portrait pages have to navigate to another portait page,
and hyperlinks from landscape pages have to navigate to another landscape page.
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Page Link
. URL link

1.

2

3. Opening a hyperlink in the device browser
4. Integrate embedded web content
5
6

. Custom URL schemes
. Mail link

You can create a hyperlink that refers to any page within your book (i.e. publication).
Page hyperlinks from portrait pages have to navigate to another portait page, and
hyperlinks from landscape pages have to navigate to another landscape page.

You can create a hyperlink that links to an external URL. On the tablet, tapping such a link
will open a browser popup window for that URL within the app. Once the user has finished
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using the browser, tapping the "Done" button of the browser popup will bring the app
back to the foreground.

Although in most cases, you want to keep readers in the embedded browser, sometimes
you may want to open a link directly in Safari on iPad or in the default browser on
Android. A good use case for this is if you want to link to a PDF that you want readers to
be able to download.

You can do this by adding an extra parameter to your URL:
tp-open-in-device-browser=1
ILJ Click to copy

The URLs below will open in the embedded app browser:

¥ http://www.website.com/file.pdf?id=1
¥ http://lwww.website.com/file2.pdf

And these will open in the device browser:

¥ http://lwww.website.com/file.pdf?id=1&tp-open-in-device-browser=1
¥ http://lwww.website.com/file2.pdf?tp-open-in-device-browser=1
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Embedded content will always be available, even when a user is offline.

All local content, including assets, JavaScript, etc., should be placed in a WebResources
folder within the folder where your InDesign book or document is located. The folder will

be created by the plug-in automatically. Note that the contents should not be zipped,

and should be placed there as is. You can organize several embedded hyperlinks by

creating different subfolders in the WebResources folder.

Once you have copied all your html content and assets to that location, enter the
Destination URL in the hyperlink field as shown below:

webresource://index.html
webresource://subfolder/index.html

ILJ Click to copy

Twixl Publisher supports a wide range of custom URL schemes for triggering specific
functions in your apps. Check the article below for more details about this:

¥ Custom URL schemes for Twixl apps

You can create a hyperlink that links to an email address with an optional subject.
Tapping such a link in the app will open a mail popup window to that email address and
optional subject. Once the e-mail has been sent, the app returns to the foreground.
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TIP:

For more advanced info about mail links, see this article: Mailto hyperlinks

IMPORTANT NOTE:

If you want to turn text information into a hyperlink, it may seem logical to select
the text in the text block, then turn it into a hyperlink. Depending on the point size
of your text however, you may decide to place a transparent rectangle on top of
the text and attach the hyperlink to that, so you can be sure the tap target is big
enough (Apple recommends a minimum size of 44 x 44 pixels for such targets).
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Images

Allow full-screen viewing of images

Place your image and you'll notice that the Twix| Publisher palette will offer the option to
assign an interactive element to that image. The only option available for image frames
in InDesign is Full Screen Image

Selecting this option will allow a reader to view the image in full-screen by double-
tapping.
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Image Sequences

Add 360j views or other types of Image Sequences.

The Image Sequence option lets a user walk you through a series of images while
swiping. The most frequent application for this is to give a 360j view of an object.

¥ You can use a series of images (either JPG or PNG) that have the same root name
with a numbered suffix, e.g. bicycle _001.jpg, bicycle_002.jpg, etc.

¥ In order to get the best performance when rotating, you should use a series of at least
30 images. Do keep in mind, however, that using too many images may have an
impact on performance.

¥ Use PNG files only if you are using transparency in your images

¥ Make sure your images have the exact size as they will be displayed on the iPad

¥ In order to add optimized images for the retina iPad, make sure you folder contains
both versions for the standard resolution, e.g. bicycle_001.jpgE as well the one for the
retina iPad that has the "@2x" suffix (e.g. bicycle_001@2x.jpg)

To create an image sequence object, create a rectangle the size of your images, then
select the Image Sequence palette.

In the palette, select the folder that contains the images of your sequence.
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1. Play In Reverse: This will change the rotation direction.

2. Allow Swiping to Change Images: Controls whether the reader can change the state
of the Image Sequence by Swiping.

3. Auto Play: Will start the Image Sequence automatically after the reader navigates to
this page. You can determine the Speed (in frames per second) and the Delay (in
seconds).

4. Tap to play/pause:  Allows a user to start/stop automatic playback of an Image
Sequence.

5. Allow Looping: _ This will play the series of images in a continuous loop.
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Panorama VR

Add 3D VR walkthroughs.

A panorama VR lets you view a complete environment in 360j, but also lets you tilt so you
can e.g. also have a look at the sky and at the floor within that environment.

Here you can see some examples.

The basic steps to integrate a Panorama VR in your InDesign article or publication are the
following:

1. Create your panorama image (e.g. in Photoshop or with a special camera, ...).

2. Download and install Pano2VR. This is not a free product but you can download a free
trial. Then later, depending on your needs, you can purchase a license.

3. Open your panorama image in Pano2VR and follow these basic workflow steps  to get
HTML output.

4. Put your complete HTML output in a separate folder in your WebResources folder.

5. Create a Web viewer or a Web overlay button  and link to the index.html file of your
HTML-export.
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Scrollable Content

Add scrollable text blocks and zoomable images

The 'Scrollable content' option allows you to add scrollable content to a container frame
with the following steps:

1. Create a text frame for the full length of the text.
2. Create a container of the size you want using the Rectangle Frame Tool.

3. Cut the text frame and then select 'Paste into' to Paste that text into the smaller
container frame.

The same applies to adding image content to the frame.

1. Allow Scrolling: _ Select this option to turn the current frame into scrollable content.
2. Show Scroll Bars: _ Show scroll bars when a user scrolls through the content.

3. Zooming Enabled: _ This option will allow the reader to use pinch & zoom to zoom in
and out.
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IMPORTANT NOTE:

If you want to make an image zoomable, make sure to place it in the frame at
the maximum zoom-in size that you want to allow. It will be scaled to fit in the
frame.

MAXIMUM DIMENSIONS:

The maximum size of Scrollable Content items is limited. For phones: 8400 x 8400
pX. For tablets: 15000 x 15000 px. The Twixl Publisher Preflight will warn you if you
exceed those limitations in your designs.
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Slide Shows

Use multi-state objects to create Slide Shows in a 2-step process:

1. First you'll create a multi-state object that contains the different images ("slides")
of your slide show

2. Then you'll set the different display options in the Twixl Publisher palette

A multi-state object for your slide show can be created via the Window -> Interactive ->
Object States palette.

To create a multi-state object, place a number of images in your document and align

them in a stack. then select them all, and click the "New" button in the Object States panel
to create a multi-state object. You can also change the order of the images in the slide
show.

TIP: OBJECT STATES ASSISTANT (FREE TOOL)

If you want to have extra tools at your disposal to work with Multi-State Objects,
we suggest you have a look at this free tool: Object States Assistant .

Object States Assistant is a script that provides a more efficient and effective way
of working with multi-state objects in InDesign
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Object States Assistant (OSA) adds new functionalities to the Object States panel
and improves the user experience. OSA improves states navigation, it also allows
you to add objects to specific states, as well as remove and release multiple
states in a single operation.

Improves state navigation by using menu items or keyboard shortcuts

Adds objects to all states in a single operation.

Adds objects to multiple states in a single operation.

Pastes objects into all states in a single operation.

Removes multiple states in a single operation.

Releases multiple states in a single operation.

Retains the OStateO actions after Copy and Paste.

Adds an easy way to increment the state of a OGo to StateO button action using
OStep and RepeatO.

K K K K K K K K

After you have created a multi-state object, the relevant interactive options can be
accessed from the Slide Show part of the Twix| Publisher palette.

1. Analytics Name:  Allows you to add a trackable name for the Slide Show.
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2. Transition Style:  Allows you to select a transition when changing slides.

Duration: _ Sets the duration of the transition in seconds.

4. Show Scroll View Indicator: Shows page indicators - i.e. when you select this option a
semi-transparent layer will be added at the bottom of your slide show to indicate the
number of pictures. You can control the look of this layer by selecting the background
color and its opacity, as well as the active and inactive page colors.

5. Allow Swiping To Change States: Controls whether a user can scroll through the slide
show.

6. Allow Full Screen View:  Double-tapping a slide show toggles a full screen view of the
slide show. Keep in mind that if you want to provide a full screen slide show, the
images should be available at a full screen resolution, i.e. more or less 132 ppi at a 1024
X 768 resolution.

7. Tap to play/pause: _ Allows a user to start/stop automatic playback of a slide show.

You can change the default interval of 3 seconds, and select the "Loop" option to have
a continuous playback of the slide show as long as the user remains on the same
page.

8. Auto Play: Will start the slide show automatically after the user navigates to this
page. You can change the default interval of 3 seconds (must be a minimum of 0.1
seconds), define a delay if you do not want the slide show to start immediately,
and select the "Loop" option to have a continuous playback of the slide show as long
as the user remains on the same page.

9. Play In A Loop: This option is available only when "Tap to play/pause” or "Auto Play" are
active. It provides a continuous playback of the slide show as long as the user
remains on the same page.

w
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Video

Easily add movies.

ABOUT PREVIEWING PUBLICATIONS/ARTICLES WITH VIDEOS ON IOS DEVICES

Sometimes large movies (in terms of file size) can be missing when executing a
Preview on an iOS device _ (with the Twixl Viewer Classic ). For a workaround, see

this article .

Movies can be embedded in the publication via the Window -> Interactive ->
Media palette .

You can add a video clip encoded in H.264 format.

Due to a limitation in InDesign, video files need to have the extension .mp4 and not
.m4v . If you have H.264 encoded files with the .m4v extension, you can just change the
extension from .m4v to .mp4 .

IMPORTANT NOTE:

Make sure your files are encoded at a quality optimized for mobile devices, so

that they are not unnecessarily too big, preferably not larger than 1080 pixels
wide. Also make sure that the bitrate of your video is not too high. The (sad)

reality is that some lower end devices only support SD quality with a bitrate of 2
Mbps . Movies with a higher bitrate can be problematic on a lot of older (mainly

Android) devicesE
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Either a frame from within the movie, or an image can be set as a poster frame. Basically,
you can also place any text block or image object(s) on top of the movie, e.g. "Click to
play movie" or a movie player icon as an indicator for the user. Likewise, if you insert an
MP3 audio file, you can place any type of button or text object on top of it. Clicking that
object on the iPad will play/stop the sound sample.

If you select "Place a video or audio file" from the media palette, that clip will be
embedded in your app.

You can also add a video clip that will be streamed using the 'Place a video from a URL'
option. Obviously, if you select this option, the user needs to be online when trying to
access the movie.

When a video or audio clip is selected in InDesign, the Twixl Publisher palette also allows

you to control the settings relevant for the tablet app.
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1. Show Movie Controller: Provides the user with the standard movie controller options
to play/pause etc.

2. Play In A Loop: Provides a continuous playback of your movie clip.

3. Play on page load: _ Will automatically start a movie clip when a user navigates to that
page, and you can set an optional delay for the movie to start.

4. Play Full Screen: Will automatically play the movie in full-screen mode when started
(movies that don't automatically play full screen can always be zoomed using the
movie controller options).

5. Return to poster frame after playback: Does exactly that.

6. Stream Movie: If you are adding a movie to a publication that will be added to a kiosk
app on the Twixl Distribution Platform, checking "Stream Movie" will transparently
make it available for streaming, so that the movie does not take up valuable space in
the app.

ABOUT PUBLIC vs. PRIVATE
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When you link Vimeo or YouTube inside a Twixl app, that video needs to be
available for everyone.  Videos that have privacy settings enabled, will not
work.

When drawing a rectangle frame, you can select the element to be a YouTube or a
Vimeo movie.
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Just enter the ID of the Youtube or Vimeo video in the Video ID field. You can select
exactly the same options that are available for an embedded movie.
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Audio

Easily add sound clips.

¥ Sound can be embedded in the publication via the Window -> Interactive ->
Media palette .
¥ You can add a sound clip encoded in the MP3 format.

¥ If you insert an MP3 audio file, you can place any type of button or text object on top of
it. Tapping that object on the device will play/stop the sound sample.

¥ If you select "Place a video or audio file" from the media palette, that clip will be
embedded in your app.
¥ When an audio clip is selected in InDesign, the Twix| Publisher palette  also allows you

to control the settings relevant for the tablet app.
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1. Play in A Loop: Provides a continuous playback of your sound clip.
2. Play On Page Load: Will automatically start a sound clip when a user navigates to that
page, and you can set an optional delay for the sound clip to start.
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Web viewers

Add dynamic web content to your publication.

Any rectangle on a page can be turned into a Web Viewer . A web viewer allows you to
add dynamic web content to your application. Integrate live content such as a Twitter
feed, integrate HTML5 apps or animations.

Create a rectangle, then use the Web Viewer panel to enter the URL of the web page you
want to display within its boundaries.

Embedded content will always be available, even when a user is offline.

All local content, including assets, JavaScript, etc., should be placed in a WebResources
folder within the folder where your InDesign book or document is located. The folder will

be created by the plug-in automatically when you define a Web Viewer for the first time.

You can then select Show WebResourceskE  to navigate to that folder in the Finder. Note

that the contents should not be zipped, and should be placed there as is. You can

organize several embedded web viewers by creating different subfolders in the

WebResources folder.

Once you have copied all your html content and assets to that location, use the "E"
button in the Web Viewer panel to select the index page of your HTML content.

The URL will look like the example below:

webresource://index.html

ILJ Click to copy

webresource://subfolder/index.html

ILJ Click to copy
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TIP:

Use embedded web content to integrate HTML5-based animations.

ABOUT WEBRESOURCES:

For more info about the WebResources folder, see this KB-article

1. Allow User Interaction: Configures whether a user can interact with the content or
not.

2. Open Links Inline: _ Will open all links in that same web viewer window - if this is
unchecked, tapping links in a web viewer will open the browser pop-up window (this
is the same pop-up window as the one triggered by http hyperlinks).

3. Show Scroll Bars:  Whether or not to show scroll bars when scrolling through the web
viewer.

4. Transparent Background: Allows you to display web content transparently on your
InDesign background. In order for the transparency to work properly, however, the
HTML source must not have a background color.
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5. Scale Content to Fit: _ If you want the width of the content to be adjusted to the width of
your web viewer. NOTE: Some web pages may not resize properly.

If you want to add a link to a page in your publication from within a web viewer window,
you can do so by creating an HREF like the one below:

tp-pagelink://{article_name}/{page_number}

ILJ Click to copy
An example would be:

<a href="tp-pagelink://TOC/3">

ILJ Click to copy

Custom URL Scheme
tp-toolbar://toggle

tp-toolbar://show

tp-toolbar://hide

tp-store://show

ILJ Click to copy
For an overview of all custom URL schemes for

Create in InDesign

Function

toggles the current view, whether visible
or invisible.

Twix| Publisher, check this article .
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Displaying a PDF in a web viewer (either embedded or online) is possible only on the iPad.
To achieve a similar result on Android, you may need to create a web hyperlink to the
PDF.

You can also decide to  open a URL in the device browser, _ e.g. if you want to allow readers
to save a PDF.

Sometimes you may want to display embedded web content if a reader is offline, and
online web content if the reader is online. Check out this article to learn how this can be
done.

If you want to quickly add a snippet of HTML code, you can select Raw HTML from the list
of elements and just paste the code in the 'Raw HTML' field. There is no need to create
separate html pages in the WebResources folder.

The Requires an internet connection option allows you to check whether a user is online
first.
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Web overlay buttons

Instead of using a URL hyperlink to open a browser window on top of the whole
publication, or displaying web content within your page using a web viewer, you can
also choose to display a 'Web Overlay', i.e. a modal web viewer that is displayed on
top of your page. The 'Web Overlay' will always be positioned at the center of the
page and add a level of transparency to the rest of the page.

To create a web overlay, first create an object that will serve as the button that triggers
the overlay. When the object is selected, click 'Web Overlay Button' in the Twixl Publisher

palette.

1. URL to Trigger: Enter the URL to be displayed in the overlay here. Similar to Web
Viewers , web overlays can also be used to load embedded HTML content. All local
content, including assets, JavaScript, etc., should be placed in a WebResources folder
within the folder where your InDesign book is located. You can select "Show
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WebResources" to navigate to that folder in the Finder. Once you have copied all your
html content and assets, use the "E" button in the Web Overlay panel to select the
index page of your HTML content.

2. Analytics Name:  Enter a reference that will be used in the analytics information.

3. Width and Height: __ Enter the size of the web overlay (in pixels) here. When left empty,

the web overlay will go full screen.

4. Background color: __ The color of the layer that will be placed on top of the content
outside the web overlay.

5. Opacity: Opacity of the transparent layer.

6. Allow User Interaction: Configures whether a user can interact with the content or
not.

7. Show Scroll Bars:  Whether or not to show scroll bars when scrolling through the web

viewer.

8. Show Loading Indicator: Can be used to provide the user with some feedback while

the page is loading - typically this will be used only for external and not for embedded
content.

Embedded content will always be available, even when a user is offline.

All local content, including assets, JavaScript, etc., should be placed in a WebResources

folder within the folder where your InDesign book or document is located. The folder will
be created by the plug-in automatically when you define a Web Viewer for the first time.
You can then select "Show WebResourcesE" to navigate to that folder in the Finder. Note
that the contents should not be zipped, and should be placed there as is. You can
organize several embedded web overlays by creating different subfolders in the
WebResources folder.

Once you have copied all your html content and assets to that location, use the URL to
trigger "E" button in the Web Overlay button panel to select the index page of your HTML
content.

The URL will look like the example below:

webresource://index.html

ILJ Click to copy

webresource://subfolder/index.html

ILJ Click to copy

ABOUT WEB RESOURCES:
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For more info about the WebResources folder, see this article
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Map

Add a map with ease

1. Address: Enter the address here like you would in the search bar
on http://maps.google.com or the Apple Maps app.

2. Info window : here you can enter the text that you want to display for that location.
3. Display As :allows you to select the map type.
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Animations

How to integratie animations in your InDesign content.

HTML5 animations can be created with several tools, like:

¥ Adobe Animate
¥ Tumult Hype

Twixl Publisher has direct support for the .oam file format used by Animate (and which
Tumult Hype can also export to). These .0oam package files can be added to InDesign via
simple drag 'n' drop, and InDesign will then also display a preview of the animation.

TIPS:

¥ Always create responsive projects or create your animation with the desired width
and height (as it will be used in InDesign).

¥ We strongly advise you to use a .html export together with a Web Viewer or Web
Overlay Button . It's less unpredictable and what's even better: You can test your
animation easily by testing it in every browser (desktop, iOS, Android).
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Nested Interactivity

Twixl Publisher allows you to embed certain interactive elements within scrollable
content or within a slide show.

The following types of nested interactivity are supported in scrollable content or in slide
shows:

¥ action buttons, hyperlinks and web overlay buttons
¥ audio

¥ video

¥ web viewers

¥ .oam files

¥ panorama VR

NOTE:

Placing scrollable content inside an MSO (slide show,...), or putting an MSO inside
a scrollable content area is not supported. Nor is a scrollable inside a scrollable,

or an MSO within an MSO.

For nested interactivity in scrollable content, group the scrollable content itself with the
extra interactive element(s), before selecting 'Paste Into' to paste the grouped content
into the scrollable frame.

For nested interactivity in a slide show, group the extra interactive element(s) with an
image that you want to add to the slide show, before converting it to a multi-state object.
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The order of interactive elements

How the plug-in handles multiple stacked interactive elements.

When the plug-in creates an export, each page will consist of:

¥ a base layer with the base image (all non-interactive content)
¥ an extra layer per interactive overlay

All interactive overlays are placed on top of the base layer in a specific pre-determined
order:

1. base layer (bottom)
movie

sound

web viewer

web overlay

image sequence
scrollable
full-screen image

9. slide show

10. web link

11.page link

12. button action  (top)

©~NOOhwN

REMINDER IN INDESIGN:

Our templates in InDesign have all these overlays on board as layers. You are not
required to use them, but in any case it is a handy way to remind you to the
exact order of interactive elements!
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Preflight

When creating a

number of preflight checks.

The preflight process will check the following items:

¥
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¥

Depending on the severity, the preflight will generate either a warning (and allow you to

Missing linked items (images, ...)

Missing fonts

Image resolutions based on the alternate layout
Page sizes

Alternate layout names

Alternate layout page counts

Size of scrollable contents

Multistates (to see if they don't exceed the page size)
Image Sequences (source folder, does it contain image files, the correct file format,
image sizes, ...)

Buttons (unsupported events, E)

continue), or generate an error (in which case you cannot continue until the problem is
fixed).

Create in InDesign
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In the plug-in preferences, you can select whether warnings are displayed when doing a
preview, or when sharing and exporting. If you uncheck both, then Preflight will only bug
you when it encounters an error and is unable to continue.
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Preview InDesign content in the simulator
or on a device

You can preview the result of your interactive InDesign content either in the iI0S
simulator (on macOS only) or in the Twixl Viewer Classic app running on an iOS or
Android device on your Wifi network.

When selecting Preview for an article or publication from the plug-in, you are presented

with a list of devices running the Twixl Viewer on the local Wi-Fi network, as well as a list of
simulators (on macOS only). So if you want to preview on a device, open the free Twixl
Viewer Classic _app first, then select  Preview from the Twixl Publisher plug-in palette
(whether for a single article or for a complete publication).

If the device you are looking for does not appear in the list, you can select Use IP
addressE to manually enter the IP address listed in the bottom toolbar of the Twixl Viewer
window on your device.
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Selecting Preview in the macOS app presents a popup sheet similar to the list sheet in
InDesign.
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In order to test whether there are any network issues, go to your browser and enter the
following URL:

http://[IP address of tablet device]:53652/

ILJ Click to copy
e.g.

http://192.168.1.10:53652/

ILJ Click to copy
You should get a result with the device type and the Twixl Viewer version number like:

"info": "TwixI Publisher Helper 14.0 build 36460"
}

ILJ Click to copy

IMPORTANT NOTE

If a soft- or hardware firewall is active on your network, and you seem to be
unable to send a preview to a device, make sure to ask the network
administrator to open TCP ports 53652 & 53654 .
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¥ Twixl Viewer Classic for iOS (iPads & iPhones) is available for download from the App
Store .

¥ Twixl Viewer Classic for Android (tablets and phones) Is available from  Google Play .

¥ A download link is available directly from the Twixl Publisher plug-in window as well.
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1. Tap the "i" icon in the bottom right corner to bring up the info menu.
Go to the documentation.

Report a problem (sometimes used for troubleshooting purposes ).
Download a sample publication.

Go to the Twixl Viewer Classic settings in System Settings.

Version and build number.

SEGIFARN
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Sharing an article or publication

Sharing an InDesign article or publication with a client, either from the plug-in or from
the macOS app, isjustas easy acreating a Preview.

For a quick overview, check out the video below.

¥ Select Share either from the plug-in panel or from the macOS app
¥ Enter the e-mail address of sender and receiver and an optional message
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¥ After clicking "OK", the publication will be uploaded to Twixl servers
¥ The sender and receiver will get an e-mail confirmation when the upload has been
processed
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¥ The sender still has the option to remove the publication

¥ If the receiver has not yet installed the Twixl Viewer , the confirmation message
contains download links for Twixl Viewer Classic for iOS and Android.
¥ Tapping the e-mail link "Open with the Twixl Viewer" on the device will open the viewer

and start downloading the publication.

Create in InDesign Page 72


https://twixlmedia.zendesk.com/hc/en-us/articles/115002057809-downloads

2.3. Downloading the shared publication/article

¥ The sender will geta read receipt.

¥ All this happens without the need to

00 T T « * > B~ B Moeto.

e E3inbox - TWIXL MEDIA  17:44
Download confirmation from demo@twiximedia.com for *Avantgand_buildtest” via Twixl..  Detalls
To:

TWIXL PUBLISHER

DEMO@TWIXLMEDIA.COM
DOWNLOADED
AVANTGAND_BUILDTEST

Here is the first version of your digital publication!

Publication
Avantgand_buildtest
Download original file

Will be deleted on
12 march 2020

Download link

create and manage an

accountE
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Export

Export a single article or a complete publication or separate articles.

Once you have finalized your design, and have added the interactive elements you
wanted to include, you can select "Export article" or "Export PublicationE", available from
the Twixl Publisher palette.

Choose a destination for the export package and click OK. The Twixl Publisher plug-in will
now export all contents (possibly different versions for landscape and portrait, or
different form factorsE)

Twixl Publisher 15.3

Publication Article
Properties Publication Article
Preview Publication Article

Publication Article

@Publication @ Article

Separate Articles

Alternate Layouts

Preferences

One InDesign document -> .article file

If you are exporting one article (possibly consisting of multiple pages), then a package
file with the extension .article will be generated.
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Complete InDesign book -> .publication file

For a complete export of an InDesign book, a package file with the extension .publication

will be created.

TIP ABOUT .PUBLICATIONS AND THE TWIXL PLATFORM:

When uploading a .publication file to the Twix| platform, it will automatically be
split in different .article content items during post-processing.

Complete InDesign book -> separate .article files

You can also export all members of your book (.publication ) as separate .articles .

TIP ABOUT EXPORTING AS SEPARATE ARTICLES:

InDesign has always been rather buggy when it's about exporting book files. Most
of the time they are caused by too many book files, too many fonts, etc. This also
influences the export or preview actions from Twixl Publisher. If your InDesign
book fails to export, you can also use this functionality to export separate articles
and avoid crashes.

ABOUT WINDOWS :

On Windows, the . article or .publication package file will appear as a folder.

PREFLIGHT:

When exporting an article or a publication, Twix| Publisher will always start a
preflight check first.  If the plug-in detects a problem, depending on the severity,
you may or may not choose to continue the Export.
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Web Resources are used to embed (HTML) content in a .publication or .article . They
are also used in case of shared content (e.g. a movie that is used in different
.articles). Different Export options have different consequences. We explain them
briefly here:

1. Exporting a .article that is part of an InDesign-book: The Web Resources folder of the
InDesign-book will be completely integrated in the export of your each of the .article
packages.

2. Exporting a .article that is not part of an InDesign-book and was created
independently:  The Web Resources folder of the InDesign-article will be completely
integrated in the export of your .article - and so will only contain those resources that
are required for that article.

3. Exporting as separate .articles (all articles of an InDesign-book): Each article will
include a complete copy of the Web Resources folder from the InDesign-book.

If your Web Resources folder doesn't contain a lot of huge files, you can choose for the
automatic management: exporting a complete .publication or exporting as separate
.articles will do just fine.

If all of your .articles contain a lot of huge files in the Web Resources folder, it's best to
create separate InDesign-articles and export all of them separately. You can also
combine them in a book-file afterwards, but you need to start with the creation of
separate Articles first (separate InDesign-files):

¥ Create all new Articles (via the Twixl Publisher plugin)

¥ Populate your Web Resources with the necessary files, only needed for each specific
.article

¥ Group all InDesign files in an InDesign .publication (an InDesign-book file)

¥ Use the Export as Articles  so that you get an optimized .article export for each article.
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InDesign CC2021.: | can't edit Twixl movies
parameters

When | select a movie in my InDesign-plugin (I'm working in InDesign CC2021), the plugin
doesn't display the Movie settings window.

In InDesign CC2021, Adobe removed a certain a property to use in the Ul. This is causing
the error.

A fix is available in Twixl Publisher 13.1

CHECK YOUR PARAMETERS!

Since this is actually about a conversion, when opening documents containing
movies in CC2021, we strongly advise you to check all the settings! Better safe
than sorry!
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Blank Twixl Publisher InDesign plugin-
window on Windows

The Twixl Publisher plugin-window remains blank, there is no interface. See screenshot.

Twixl Publisher 10.6

This problem is caused by faulty permissions on your Windows-system

Execute the following steps to force-fix the permissions for your Twixl Publisher plugin-
installation:

¥ Close InDesign.

¥ Navigate to the path C:\Program Files (x86)\Common Files\Adobe\CEP\
extensions

¥ Delete the following folders:  Twixl Importer , Twixl Importer HTML , Twixl Publisher and
Twix| Publisher HTML.

¥ Run the Twixl Publisher for Windows installer again.

¥ Start InDesign
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¥ Your Twixl Publisher plugin should now be displayed properly.

Twixl Publisher 10.6

Properties

Preview

Export

Publication

Publication

Publication

Publication

Publication

Article

Article

Article

Article

Article

Separate Articles

Alternate Layouts

Preferences
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| can't generate alternate layouts

When you try to add Alternate Layouts using the Twix| Publisher tool Alternate Layouts , no
Alternate Layouts are being generated. You get no error-messages.

This is caused by a rather messy bug in InDesign when you have duplicate names in your

Text Styles and selected Copy Text Styles to New Style Group  as an option in the Twixl
Publisher Alternate Layouts panel.

E.g. you are using the same name for a Paragraph Style and a Character Style

EXTRA INFO:

To confirm this error, you can always try to add an Alternate Layout using the
standard InDesign functionality. Then you'll get this strange error:

One or more styles were not mapped. Cannot create a mapped style when one of the
source styles is based on another source style (OK).

This InDesign-error has in fact nothing to do with "based-on"-styles at all.
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Character Styles Paragraph Styles

Duplicate Name Duplicate Name ] #

[None] [Basic Paragraph]

Duplicate Name Based on Paragraph Style Level 1
Based on Paragraph Style Level 2
Based on Paragraph Style Level 3

Duplicate Name

Create Alternate Layouts

Article

File Name Nested Styles.indd

Select the alternate layout(s) to create

Create "iPad V"

Create "Android 10" H"

Create "Android 10" V"

Create "Kindle Fire/Nook H (Android 7")"
Create "Kindle Fire/Nook V (Android 7")"
Create "Phone H"

Create "Phone V"

Options
Link Stories

Copy Text Styles to New Style Group

Just rename one of your Text Styles, so you no longer have duplicate names.
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Character Styles Paragraph Styles

Name 2 Name 1 ] #

[None] [Basic Paragraph]

Name 2 Based on Paragraph Style Level 1
Based on Paragraph Style Level 2
Based on Paragraph Style Level 3

Name 1
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